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LibreOfiiee Doiuments
Currente Doiument
Dim Doc As Object
Doc = ThisComponent
Openinge ane existinge doiument
Ine Visiblee Mode
Dim Doc As Object, DocPath As String
Dim Props()   'here, an unitialized table
DocPath = ConvertToURL("C:\Path\To\SomeSpreadsheet.ods")
Doc = StarDesktop.loadComponentFromURL(DocPath, "_blank", 0, _

Props())

Ine hiddene Mode
Dim Doc As Object, DocPath As String
Dim Props(0) As New com.sun.star.beans.PropertyValue
DocPath = ConvertToURL("C:\Path\To\SomeSpreadsheet.ods")
Props(0).Name  = "Hidden"  'the document is opened as hidden
Props(0).Value = True
Doc = StarDesktop.loadComponentFromURL(DocPath, "_blank", 0, _

Props())

Makee visiblee ane hiddene doiument
Doc.CurrentController.Frame.ContainerWindow.Visible = True
Doc.CurrentController.Frame.ContainerWindow.toFront()

Creatinge ae newe ialie doiument
From (1) the default template or (2) a specified template.
Dim Doc As Object
Dim Props()   'here, an unitialized table
Template = "private:factory/scalc"        '(1)
'or
Template = "C:\Path\To\SomeTemplate.ots"  '(2)
Doc = StarDesktop.loadComponentFromURL(Template, "_blank", 0, Props())

Savinge ae doiument
Thee doiumente alreadye exists
(same as File > Save)
Use the document object store method. Ex: ThisComponent.store
Thee doiumente wasn’te savede yet
(same as à File > Save As)
Dim Doc As Object, DocPath As String
Dim Props()             'save properties (empty)
DocPath = convertToURL("C:\Path\To\SomeSpreadsheet.ods")
Doc.storeAsURL(DocPath, Props())

☞ In case of a duplicate, it becomes the active document.
Savinge ae iopy
As above, using Doc.storeToURL(DocPath, Props())
☞ The copy won’t become the active document.
Closinge ae doiument
Use the document object close method: ThisComponent.close(True)
Gettinge doiumente information
Thee doiumente objeite exposese properties
Location The document storage directory

☞ 0-length string if not saved yet.
DocumentProperties (Object) Some more information (see below).
DoiumentPropertiese (Filee >e Properties)
Author Author’s name. ModifyDate Last modification date.
CreationDate Creation date. Subject Subject (String).
Description Comments. Title Title (String).
ModifiedBy Name of the user who 

modified the document.
UserDefinedPr
operties

Custom properties (Object).

Ise thise ae Calie doiument?
Doc points to the document (ex : Doc = ThisComponent).
CalcOK = Doc.SupportsService("com.sun.star.sheet.SpreadsheetDocument")

Calie –e General
The Doc object points to the document (ex : Doc = ThisComponent).
Automatiie ialiulation
Active? (Boolean) Auto = Doc.isAutomaticCalculationEnabled
Deactivate Doc.enableAutomaticCalculation(False)
Activate Doc.enableAutomaticCalculation(True)
Force calculation Doc.calculate (only non updated formulas)

Doc.calculateAll (everything)
Proteitinge thee spreadsheet
Is the document protected? Test = Doc.isProtected
Protect document Doc.protect(Password) '[may be empty]
Unprotect document Doc.unprotect(Password)
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Sheets
The Doc object points to the document (ex : Doc = ThisComponent).
Gettinge sheets
Working with sheet objects (index is 0-based):
The active sheet ASheet = Doc.CurrentController.ActiveSheet
The sheets list TheSheets = Doc.Sheets
Sheet count SheetNum = Doc.Sheets.Count
Sheet object (by index) ASheet = Doc.Sheets(index)
Sheet object (by its name) ASheet = Doc.Sheets.getByName(SheetName)
Check existence (name) Exists = Doc.Sheets.hasByName(SheetName)
Sheet index SheetIndex = ASheet.RangeAddress.Sheet
Modifiyinge sheets
Below p is the position in the spreadsheet (base 0).
Adding a named sheet Name Doc.Sheets.insertNewByName(Name, p)
Deleting a sheet Doc.Sheets.removeByName(SheetName)
Duplicating a sheet Doc.Sheets.copyByName(SrcName, TgtName, p)
Moving a sheet Doc.Sheets.moveByName(SheetName, p)
Managinge sheets
ASheet is a sheet object.
Activating a sheet Doc.CurrentController.ActiveSheet = ASheet
Hiding/showing a sheet ASheet.IsVisible = False 'True
Checking protection Protected = ASheet.IsProtected
Protecting a sheet
(Pwd can be empty)

ASheet.protect(Pwd)

Unprotecting a sheet ASheet.unprotect(Pwd)
Tab coloring ASheet.tabColor = RGB(255, 255, 0)

Linkinge ae sheet
Linking to a file (ex: 
CSV)

ASheet.link(URL, "", "Text - txt - csv (StarCalc)", _
       Filtre, com.sun.star.sheet.SheetLinkMode.VALUE)

Destroying a link ASheet.setLinkMode(com.sun.star.sheet.SheetLinkMode.NONE)
Findinge thee laste usede row/Col
ASheet is a sheet object.. Row and Col are the values to retrieve.
Dim Cur As Object 'cell cursor
Dim Range As Object 'the used range
Dim Row As Long, Col As Long
Cur = ASheet.createCursorByRange(ASheet.getCellRangeByName("A1"))
Cur.gotoEndOfUsedArea(True)
Range = ASheet.getCellRangeByName(Cur.AbsoluteName)
Row = Range.RangeAddress.EndRow
Col   = Range.RangeAddress.EndColumn

Cells
Below, ACell is a cell object.
Gettinge iells
ASheet is asheet object. You can get the cell object:
Through its R/C coordinates ACell = ASheet.getCellRangeByName("A4")
Through its name ACell = ASheet.getCellRangeByName("VAT")
Through its XY coordinates ACell = ASheet.getCellByPosition(0,3)

with X=0 (col.A) ; Y=3 (row 4)
Knowinge thee aitivee iell
Doc is a document object and ACell is the active cell we’re looking for.
If Doc.currentSelection.supportsService _ 

("com.sun.star.sheet.SheetCell") Then
'it's a cell
ACell = Doc.currentSelection

End If

Seleitinge ae iell
ThisComponent.CurrentController.select(ACell)
Celle Coordinates
Coordinates (Object) Coord   = ACell.CellAddress
Sheet index (Integer) NumSh   = ACell.CellAddress.Sheet
Column index (Long) NumCol  = ACell.CellAddress.Column
Row index (Long) NumRow  = ACell.CellAddress.Row
Container sheet object ASheet  = ACell.Spreadsheet
Absolute coordinates (String) Coord   = ACell.AbsoluteName
(Un)Proteitinge iells
The ACell.CellProtection property can get the boolean values:
No modifications CellProtection.IsLocked = True
Hide formula CellProtection.IsFormulaHidden = True
Hide cell CellProtection.IsHidden = True
Don’t print cell CellProtection.IsPrintHidden = True
Gettinge ae ielle iontents
Properties
Getting text contents MyText   = ACell.String
Getting numerical contents ANumber  = ACell.Value
Getting a formula (US) AFormula = ACell.Formula
Getting a formula (local lang.) AFormula = ACell.FormulaLocal
Knowing content type (below) TheType  = ACell.Type
Emptying a cell ACell.String = ""
Contente Typese (Typee property)
The com.sun.star.table.CellContentType.XXX constants can tell the type of contents 
(ACell.Type, above):
EMPTY Empty cell VALUE Contents is numerical
TEXT Text contents FORMULA Contents is a formula
Writinge ine ae iell
Replacing existing text ACell.String  = "Hello!"
Replacing existing value ACell.Value   = 1,234
Replacing existing formula ACell.Formula = "=AND(A1="YES";A2="OK")"
Replacing existing  formula (FR) ACell.FormulaLocal = "=ET(A1="YES";A2="OK")"



Ranges
Range = a set of cells (one cell is a range): Dim MyRange As Object
Gettinge Ranges
ASheet is asheet object. You get the ARange range object:
Ny its coordinates ARange = ASheet.getCellRangeByName("C2:G14")
By its name ARange = ASheet.getCellRangeByName("NomDePlage")
By its coordinates
(X1, Y1, X2, Y2)

ARange = ASheet.getCellRangeByPosition(2, 1, 6, 13)

Arbitrament
(ex 3rd  sheet)

ARange = ThisComponent.Sheets.getCellRangeByPosition(
2, 2, 1, 6, 13)

Gettinge thee aitivee range
Like for the active cell, but verify the  "com.sun.star.sheet.SheetCellRange" or 
"[...].SheetCellRanges" services.
Seleitinge ae range
ThisComponent.CurrentController.select(ARange) where ARange is an object.
Rangee Coordinates
Coordinates (Object) Coord  = ARange.RangeAddress
Sheet index (Integer) Rang   = ARange.RangeAddress.Sheet
Column index (Long)
top/lef

NumCTL = ARange.RangeAddress.StartColumn

Row index (Long)
top/lef

NumLTL = ARange.RangeAddress.StartRow

Column index (Long)
bottom/right

NumCBR = ARange.RangeAddress.EndColumn

Row index (Long)
bottom/right

NumLBR = ARange.RangeAddress.EndRow

Containing sheet object ASheet = ARange.Spreadsheet
Absolute coordinates (String) Coord  = ARange.AbsoluteName

Namede ranges
The Doc object points to the document. Also Ranges As Object
Named ranges Ranges = Doc.NamedRanges
Ranges count (Long) Count  = Ranges.Count
Getting a range (by index) ARange = Ranges(index)
Checking existence (by name) Existe = Ranges.hasByName(Name)
Getting a Range (by name) ARange = Ranges.getByName(Name)
Adding a range
Coord : Range coordinates
CellRef : reference cell object.

Ranges.addNewByName(Name, Coord, _
CellRef.CellAddress, 0)

Removing (by name) Ranges.removeByName(Name)
Clearinge ae range
Clearing ARange contents ARange.clearContents(DelMode)
DelMode is a value that specifies the deletion type. com.sun.star.sheet.CellFlags.XXX 
constants give that choice (combine with +) :
ANNOTATION Comments STRING Text
DATETIME Number formatted as date-time VALUE Numbers (except date-time)
FORMULA Formulas
Gettinge ae rangee iellse Contents
ARange.DataArray est un tableau des valeurs des cellules pour ARange.
Copyinge ae rangee iontentse toe anothere range
Two ranges Source and Target, of the same dimensions.
Copying the contents (values) of Source into 
Target.

Target.DataArray = Source.DataArray

Writinge valuese intoe ae range
ARange is a range object, Table is a table of the same dimensions, which values have to be 
copied into the range.
Dim Table As Variant
Table = ARange.DataArray 'Table has the same dimensions as the range
'(ste the array items values)
ARange.DataArray = Table

☞ .DataArray is a nested array: use .DataArray(i)(j)
browsinge ae rangee iells
From a collection (Ranges.Cells), we create an enumeration. It is then browsed by calling 
its hasMoreElements et NextElement properties:
Dim Ranges As Object
Ranges = 

ThisComponent.createInstance("com.sun.star.sheet.SheetCellRanges")
Ranges.insertByName("some name", ARange)
TheEnum = Ranges.Cells.CreateEnumeration
Do While TheEnum.hasMoreElements
TheCell = TheEnum.NextElement
'do smthg with the cell object

Loop

 Empty cells are not browsed!
Rangese misi.
Merging ARange object cells ARange.Merge

Rangese types
The range access mode defines which service it implements:
① com.sun.star.sheet.SheetCell ④ com.sun.star.sheet.SheetCellRange
② com.sun.star.table.CellRange ➄ com.sun.star.sheet.SheetCellRanges
③ com.sun.star.sheet.NamedRange
 The implemented service implies how the ranges should be used.

Check using their supportsService() method (ex. below)

Rangee ore iell?
To know an object type, test supportsService() on a Range or Cell:
If MyObj.supportsService(Service_Name) Then …
Replace Service_Name with:
Cell? "com.sun.star.sheet.SheetCell" ①
Simple Range? "com.sun.star.sheet.SheetCellRange" ④
Multiple Range? "com.sun.star.sheet.SheetCellRanges" ➄
 Always check for a Cell type before a Simple Range as a cell is also a Simple Range!

Rows/Columns
Rows and columns are properties of Sheet and Range objects.
Overview
Rows (oRows object) oRows = ARange.Rows
Columns (oCols object) oCols = ARange.Columns
Number NumL = ARange.Rows.Count

NumC = ARange.Columns.Count
A Row (oRow object) (base 0) oRow = ARange.Rows(index)
A Column (oCol object) (base 0) oCol = ARange.Columns(index)
Rows/Columnse Properties
Apply to Row or Rows objects (resp. Column or Columns).
Visible/Hidden (Boolean) IsVisible = True
Optimal width or not (Boolean) OptimalWidth = True
Inserting/Deletinge rows/Columns
Given the objects RorC, FirstPos and LastPos the starting and ending positions for the 
rows set (resp. columns) to insert or delete (Long).
Inserting RorC.insertByIndex(FirstPos, LastPos)
Erasing RorC.clearContents(EraseMode) [EraseMode: see Clearinge ae range]
Deleting RorC.removeByIndex(FirstPos, LastPos)

Fixinge rowse ore iolumns
☞ Only on a visible spreadsheet.
Use the controller object: oContrlr = ThisComponent.CurrentController
Is there any? Fixed = oContrlr.hasFrozenPanes
Fix oContrlr.freezeAtPosition(1, 2)
Delete oContrlr.freezeAtPosition(0, 0)

Callinge ae Calie funition
Use the "com.sun.star.sheet.FunctionAccess" service.
Overview

Dim FCalc As Object
Dim Result As (according to context)
Dim Params As (according to context)
Dim FuncName As String
FCalc = CreateUnoService("com.sun.star.sheet.FunctionAccess")
Result = FCalc.callFunction(FuncName, Params)

☞ The name, arguments and result type depend upon the target function.
 The function name must be its English name.

To get it in a non-EN environment, temporarily swap the function names in Calc using 
Tools > Options > LibreOffice Calc > Formula, Use English function names.

Examplee 1e (SUM())

Dim FCalc As Object, Result As Long
FCalc = CreateUnoService("com.sun.star.sheet.FunctionAccess")
Result = FCalc.callFunction("SUM", Array(1, 55, 321, 8))

Examplee 2e (ROUND())

Dim FCalc As Object, Result As Double
Dim Params(1) As Variant
Params(0) = 1,2345 'nb to round
Params(1) = 3      '3 decimals
FCalc = CreateUnoService("com.sun.star.sheet.FunctionAccess")
Resultat = FCalc.callFunction("ROUND", Params())

Creatinge ae Calie funition
Creation
Example : trapezoid surface calculation (S = ((B + b) / 2)  × H)
Function TrapezoidSurface(LB As Double, SB As Double, H As Double) As 

Double
SurfaceTrapeze = ((LB + SB) / 2) * H

End Function

Usinge ine Calie spreadsheets
Given A2 is the large base, A3 the small one and A4 the height, a trapezoid surface is obtained 
by inserting the following formula into a cell: =TRAPEZOIDSURFACE(A2;A3;A4)
☞ The macro receives arguments as values, not the source cell objects.
☞ The macro returns a value. It can’t act upon a cell object.
☞ The function must be placed within a library that is available at work time (ex : Standard in 

the document or in the user’s container) (otherwise: #VALUE! error).

Credits
Author : Jean-François Nifenecker – jean-francois.nifenecker@laposte.net
We are like dwarves perched on the shoulders of giants, and thus we are able to see more and farther than 
the latter. And this is not at all because of the acuteness of our sight or the stature of our body, but because 
we are carried aloft and elevated by the magnitude of the giants (Bernard de Chartres [attr.])

History
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1.15 12/14/2019 Minor updates
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